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Abstract

This paper introduces a spreadsheet-based method of integrating project management

techniques into project-based engineering courses.  The use of a spreadsheet approach

alleviates (1) the need for institutions to purchase additional commercial project

management software and (2) additional training of faculty and students on how to use

the software.  Spreadsheet programs, for example Microsoft Excel, are already

entrenched in college computer laboratories with students and faculty having familiarity

with their use.  We present our experiences in implementing this approach in one section

(32 students) of a freshman introduction to engineering design course.  A preliminary

assessment is also presented.

1. Introduction

The use of team projects as a way to teach engineering design is pervasive across all

engineering disciplines and throughout the curriculum. The success of any design team --

both in learning design concepts and performing well -- requires that students have a

good grasp of technical and management aspects of the design process. Accordingly,

poor management or lack of communication within a team and between teams and their

faculty advisor/instructor will typically result in a mediocre project, no matter how

technically proficient team members are. The importance of team management and

common methods to achieve a successful design experience have been discussed
1-4

 .

Common methods for project management include team calendars, work breakdown

structures (WBS), Gantt/milestone charts and Program Evaluation and Review Technique

(PERT) diagrams.  This article does not introduce new management methods, but instead

focuses on how these “textbook” methods can be effectively implemented using a

common spreadsheet application, in this case Microsoft Excel (Excel).

Although commercial software is readily available to perform these tasks, such as

Microsoft Project, their adoption in a classroom environment presents several challenges.

These include: (1) design faculty may not know or feel inclined to learn how to use the

software, (2) funds may not be available to purchase the software or use of existing funds

would drain already meager resources and divert their use from other areas in the design

curriculum, and (3) requiring an additional software tool may present an unwelcome

burden for students, who are already required to learn and use a significant number of

software tools – word processing, spreadsheets, programming, illustration, image
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manipulation, website design, CAD, etc., and (4) teaching students a new software tool

will require diversion of time away from existing course material.

The use of Excel to create automated project management tools, therefore, is a natural

choice as Excel is available on virtually every college campus. In addition, students

already have a basic level of proficiency in its use allowing easy implementation. The

remainder of this article demonstrates how students can use Excel to create Project

Management Workbooks (PMWs) to incorporate the “textbook” project management

methods to their design experience. Then, it goes on to discuss how the use of the PMWs

in conjunction with a weekly coordination meeting can readily address some of the

problems often encountered in team projects: student laggards, project scallop, and lack

of communication.

The approach has been implemented in three courses (freshman design, junior reverse

engineering, and senior capstone). In this paper, we report our experience with the

approach in a freshman design course and present an assessment of its effectiveness in

relation to students’ perception on: (1) the importance of project management in design

projects, (2) the effectiveness and timing of project management concepts introduced,

and (3) the impact of project management techniques used on their design performance.

2. Project Management Workbooks

Project management involves two primary tasks: (1) planning and scheduling, and (2)

directing. Planning and scheduling involves activities for understanding the project scope

(tasks, time and budget) and organizing. These activities are to define objectives, list

tasks, estimate work and duration, determine interdependent tasks, schedule tasks and

schedule resources. Directing, on the other hand, involves implementing approved tasks

to achieve project objectives. Specific directing activities might be assigning tasks,

reviewing criteria for task completion, controlling, reporting and reviewing progress, re-

planning, reviewing completed work, resolving issues and closing project. Sections 2.1

and 2.2 will discuss how planning and scheduling, and directing can be implemented

using PMWs.

2.1 Planning and Scheduling

Various tools are available to assist in planning a project to ensure its completion in the

allotted time. The three sequential stages for project planning (with the commonly used

tools shown in brackets) are:

1. Listing all the tasks that need to be done, and estimating how long each one will

take to complete (Work Breakdown Structure).

2. Deciding which tasks can be done in parallel and which ones must be done

sequentially (Design Structure Matrix/Activity Networks).

3. Setting approximate start and end dates for all tasks (Gantt/Milestone Charts).
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a. PMW: Work Breakdown Structures
Before a student team can plan or manage a project, they need to have an idea of the

project scope. They need to know what tasks need to be performed and make estimates

on how long it would take to complete them. The Work Breakdown Structure (WBS)

divides the entire project into a series of tasks (no order is implied), and further breaks

down the tasks into sub-tasks. The level of decomposition - for example, subsub-tasks,

subsubsub-tasks - will depend on the complexity of the project. The WBS presents the

tasks in an organized form that allows team members to readily see and understand how

the tasks fit into the overall project.

Work Breakdown Structures can be presented in a graphical or a list format.  The Project

Management Workbooks implement the list format. A generic WBS implemented in

Excel for a design project is illustrated in Figure 1.

Figure 1. Sample Work Breakdown Structure implemented in the

Excel Project Management Workbook.

To the right of each sub-task description is its estimated duration.  This information will

be used to schedule the tasks appropriately and ensure that the project is completed on

time. The sum of all the individual tasks is not the time required to complete the project.

As certain tasks can be done in parallel, the overall project time will be significantly

shorter. Note that this is a dynamic document that is altered to reflect current events in

the project.  New primary or lower level tasks are added by inserting a new row

(Insert>Rows). Existing tasks can also be deleted.

Table 1 enumerates the steps to add start date and end date columns in the WBS

worksheet, where the end dates are automatically updated to reflect the current start dates
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and task durations. A modified WBS with partially populated planned start dates and

automatically calculated end dates is illustrated in Figure 3.

b. PMW: The Gantt Chart/Milestone
The Gantt Chart is the most widely used method in industry for project scheduling and

progress monitoring. Its advantages include:

1. Direct correlation of tasks with duration of time.

2. Straightforward integration of sub-tasks having separate scheduling charts.

3. Flexible time units ranging from daily to annual.

4. Visual representation for quick assessment of project progress.

The milestone chart is similar to the Gantt chart in structure, except only symbols

signifying the completion of a major task are included.  There is no indication of task

initiation or duration as in the Gantt chart. Milestones could include dates reports are due,

or completion of concept generation and selection. These two charts are often combined

creating the Gantt/Milestone chart. A sample Gantt chart in the PMW is illustrated in

Figure 4.

Table 1. Steps to create automatic end date calculation in Project Management Workbook

Work Breakdown Structure.
1. Select all the cells enclosed in the rectangle defined by the top most planned start date and the

lowest actual end date (Figure 2).
2. Format>Cells...

3. In the Format Cells pop-up menu, click on the Number tab.

4. Select Date under Category and make a format selection under Type that shows month, day and

year (for example, 01-mar-04). Next you will enter in a formula to allow the automatic calculation

of the planned end date based on values for the planned start date and corresponding task duration.

Select the top Planned end date cell - H3 in this example (Figure 3).

5. Enter the formula =IF(G3=``",``",F3+G3).  Your actual cell references will vary depending on

your specific spreadsheet.  Essentially the formula leave the current Planned end date cell (H3)

blank if the corresponding Planned start date cell (G3) is blank.  If a Planned start date has been

entered, the Planned end date cell (H3) is populated with the sum of the Planned start date (G3)

and the Task duration (F3).

6. Select the top to bottom cells in the Planned end date column (H3-H31 in this example).

7. Edit>Fill>Down, to copy the end date formula into all the selected cells.  Done!  Each time a

planned start is entered into your WBS, a planned end date will be automatically entered.  Further,

if a task’s duration is changed, the corresponding end date will be altered accordingly.
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Figure 2. Addition of formulas to calculate planned end dates in the WBS worksheet

Figure 3. Partially populated planned start dates and automatically calculated planned end

dates in WBS worksheet
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Figure 4. Sample Excel Generated Gantt Chart

c. PMW: Team Contact Information
The team contact worksheet lists all the team members with appropriate contact

information: email, phone number and mobile phone number. This will allow team

members to readily contact each other as the need arises during the course of the project.

A sample contact page is shown in Figure 5. Note that double-clicking on the worksheet

tab at the bottom of the window allows you to type in a new title for the worksheet.

Figure 5. Contact page in the Excel Project Management Workbook

d. PMW: Team Calendar
The team calendar should span the start through end dates of the project. The calendar

should be populated with all events that are relevant to the project.  These could include

meetings, deadlines, availability of team members and so on. Color - text or cell shading -

can be used to highlight or categorize particular events. The steps to create a team

calendar as part of the PMW are enumerated in Table 2. A sample team calendar is

illustrated in Figure 6.

2.2. Directing

Directing a project serves to keep it on track, making adjustments to account for

unforeseen events that might occur during project duration. This section will illustrate

how the PMW combined with email communication can be effectively used for directing.

Directing design projects should include following elements:
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Table 2. Steps to create team calendar in Project Management Workbook

1. Double-click on the Worksheet tab at the bottom of the window. Type in `Team Calendar'. For

an additional worksheet required, do Insert>Worksheet.

2. Type in the headings ‘Day’, ‘Date’ and ‘Calendar Entries’.  Make them boldface.

3. In cell B2 type in today's date.

4. In cell B3 type in the formula, =B2+1, to increment the date by one day.

5. From cell B3 select the number of cells in column B corresponding to the number of days minus

one, available for the project. For example if the project runs for seven weeks, that corresponds to

forty-nine days, you would select cells B3-B50.

6. Edit>Fill>Down to copy the formula into all selected cells and produce a sequential list of

dates from the project start to end dates.

7. Select all the populated cells in column B.
8. Format>Cells

9. In the Format Cells pop-up menu, click on the Number tab.

10. Select Date under Category and make a format selection under Type that shows month, day and

year (for example, 01-mar-04).

11. Next you will enter a formula in the column A to automatically determine the day corresponding

to the date.  In cell A2, enter the formula, =TEXT(B2,"dddd").  The formula takes the date in cell

B2 (stored as a number) and converts it to text. The “dddd” part of the formula requests that only

the day portion of the date string be assigned to the cell.

12. From cell A2 select the number of cells in column A that correspond to the populated cells in

column B.

13. Edit>Fill>Down to copy the formula into the selected cells.  The day corresponding to the

date in column B is inserted into column A.

a. Weekly coordination meeting.  The project team should meet once a week to discuss

coordination issues.  This meeting could be part of regular technical meetings or a

separate meeting.  The meeting should be scheduled for the same time each week.  This

will ensure that team members can always make the meeting. The outcome of the

meeting should include:

1. Assessment of progress from the previous week.

2. Assignment of tasks for the coming week.

3. Re-evaluation of the WBS, adding or removing tasks or updating start dates and

task durations.

4. Re-evaluation of the project Gantt/Milestone chart, making any necessary

amendments.

5. Updating the team calendar.

P
age 9.718.7



Proceedings of the 2004 American Society of Engineering Education Annual Conference & Exposition  8
Copyright © 2004, American Society of Engineering Education

Figure 6. Sample calendar worksheet in the project management workbook

At the first meeting the team should:

1. Create the project management workbook in Excel. It should consist of four parts

(1) a team contact worksheet, (2) a team calendar, (3) a work breakdown structure

and (4) the Gantt/Milestone charts.

2. Create the initial WBS.  This is based on best current estimates on what tasks are

to be performed and an approximate duration for each task.

3. Decide from the WBS which tasks must be carried out sequentially, and which

ones can be done in parallel. The team should use this information to construct an

activity network, determining the critical path and calculating slack times for all

other paths. If the critical path time (CPT) exceeds the allotted time for the

project, the team needs to reduce the time they assigned to the critical path tasks

until the CPT equals the allotted project time.

4.   Create the initial Gantt/Milestone chart for the semester. This can then be added

to the PMW as shown in Figure 4. Note that the bars representing project duration

are only outlined. Each week, as tasks are partially and fully completed, they are

filled in. Each week an additional worksheet is added to the PMW. The previous

week’s Gantt/Milestone is copied and pasted into the new worksheet.  The chart is

modified to account for project realities, and filled in to show the current project

status. For example, with reference to Figure 7, the team decided to extend the

‘Background Research’ task by an extra week as they were running behind.  This

is reflected in week three's Gantt chart. In addition to altering task duration,

adding or decomposing tasks can occur from week to week. For example, looking

at the Gantt chart for week four (refer to Figure 8), the ‘Detailed Design’ task has

been broken down into three sub-tasks, each with its own corresponding estimated

start and end times.
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Figure 7. Modification to Task Duration, Week 3

Figure 8. Addition of Sub-tasks, Week 4

b. Selection of a coordination leader.  The role of the leader is to lead team discussions

during the coordination meeting. She ensures the meeting stays focused and concludes

within a predefined time. This should be a rotating position from week to week. The

coordination leader is also responsible for taking notes at the meeting.

c. Assignment of tasks.  Teams often have a few members not contributing their fair

share to the project, yet benefiting from the communal group reward. Assigning

individual and mini-group tasks each week serves to (1) ensure that all work that should

be done in the following week is completed, (2) no team member carries an unnecessarily

heavy work burden, and (3) all team members contribute fairly to the project.

d. Assessment of tasks.  Each week, design teams must assess the extent of task

completion from the previous week. Weekly task outcomes will determine if the current

project direction is still appropriate, or if alternate paths have to be followed or solutions

sought.  In addition, it provides a written record of who has not been completing their

tasks from week to week, and therefore not fully contributing to the project.

e. Communication.  The administrative leader should send an email shortly after the

meeting to ALL team members and the project advisor(s)/course instructor, with the

PMW attached.  The email should include:

1. A list of present and absent team members.

2. A summary of the current state of the project, indicating successes, challenges and

failures. P
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3. An indication of the tasks, in some detail, that were completed the week before

and by whom.  If a particular team member did not complete their task that should

be noted and an explanation given.  Often a task may not be completed due to

underestimation of task duration, or inability to find a needed resource.  Work not

completed should be reassigned to the following week.

4. Each team member's assigned tasks for the coming week.  These tasks can be

assigned to an individual or a subset of the team depending on the task type.

The email memorandum (memo) in combination with the project management workbook

will ensure that all team members and the project advisor(s)/course instructors are aware

of the current status of the project from week to week. Each team member will know

exactly what tasks they are expected to complete that week, as well as what tasks their

teammates are working on.  The information in the memo and workbook will allow the

project advisor(s) to provide immediate feedback on the project, addressing any design

challenges that the group may be facing (for example, laggard team members or a project

falling way behind schedule) before they become critical.

3. Assessment

After its integration to design teaching, as discussed above, the assessment of the project

management using Excel was completed during Fall 2003 using one section of the

Introduction to Engineering Design course. The enrollment for the course was 31

students, who were grouped into eight design teams. Out of these 31 students, 27,

representing all eight teams, were present.   

The assessment was done by a different faculty member than the course instructor. At the

beginning of the semester between the two faculty members an agreement was

established to collaborate on the project, in a way that one would implement the approach

and the other would assess its effectiveness. Based on the implementation objectives

provided by the teaching faculty, a data collection instrument was prepared and

administered solely by the assessing partner. This instrument was not shared with the

course instructor until after the data collection was complete.

The assessment of the implementation effectiveness targeted three separate, yet very

related issues: (1) student learning related to the importance of project management in

design projects, (2) the effectiveness and timing of project management concepts

introduced, and (3) the impact of project management techniques applied on design

performance. The assessment consisted two stages. First, which used a Likert scale, was

to understand students’ perception on the three issues indicated above. Second, which

used free form answers to open-ended questions, sought to confirm the usage of project

management techniques introduced, and hence ensure that ratings for the first stage of the

data collection were valid.

 Major items investigated during first stage of the assessment are given in Table 3 with

related statements that were rated using a 1-5 scale (1 = “Strongly Disagree” 2 =

“Disagree”, 3 = Neither disagree nor agree, 4 = “Agree” and 5 = “Strongly Agree”).
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Tallied ratings showed that students at least “agree” with the fact that project

management is important (average rating > 4 = “agree”); they almost “agreed” with the

fact that introduced project management techniques were effective and timely (average

rating 3.85<4=”agree”); they at least “agree” with the fact that project management

techniques introduced made a difference in their design success (average rating > 4 =

“agree”).   

Note ratings for questions 2a and 2b were expected to be low because a good

understanding of project management should reduce the ambiguity in the project overall

and its steps.

During the second stage of the assessment, in addition to above mentioned “rated”

statements, open ended questions relating to the project management techniques used

were asked. These questions and related answers provided by each student team are given

in Table 4.

Table 3. Assessment Results
Assessment Items Average

Rating
1. The importance of project management in design projects

a.  I consider project management to be a critical part of design process. 4.2

b. A design project cannot result in a successful product unless it is managed well. 4.1

c.  I will use the project management techniques I learned throughout this class

for other projects in the future.

4.2

2. The effectiveness and timing of project management concepts introduced

a. Project steps were too ambiguous to follow. 2.5

b. We did not have explicit project steps; we did whatever seemed to be pressing. 2.6

c. We used our time very well. 3.9

d. My team had a leader who organized us, and the work to be done very well. 3.6

e. We have planned/decided our design project steps. 4.1

f. Timing of the topics related to project management was well planned. We had

enough time to learn and to apply.

3.8

3.The impact of project management techniques used on team design

performance

a. I believe project management techniques we learned made a difference in our

design performance outcome (project grade).

4.2

b. I believe project management techniques we learned made a difference in our

being more efficient with our time throughout the project.

4.0

In Table 4, student responses for each question are provided after each question is stated.

Student responses are grouped into team responses – i.e. responses from each member of

team 1 were put in the same row. The reason for this is to confirm the usage of various

project management techniques in each team. During compilation the content of the

responses were not changed. However, minor mistakes in grammar/spelling were

corrected, and content duplication was omitted. Conflicting statements were especially

left in the document. P
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As seen in Table 4, questions 1 and 2 dealt with the level of usage of the project

management methods introduced by eight design teams. After reviewing responses row

by row for each team, it is seen that every team practiced all introduced techniques. This

confirmation strengthens the rated data collected during the first stage because it shows

that ratings were done after understanding and applying all project planning and directing

tools integrated to the design teaching.

Question 3 sought to understand the easiness of the project management applications

using Excel. All students but one found it very easy to apply and understand. However,

one student found it confusing. We believe it could be due to the unfamiliarity of the

student with Excel applications. However, supporting information is not available.

Finally, question 4 intended to get students’ opinion on how the instruction could be

improved. While most students found it very effective as is, a number of suggestions

appeared as avenues for improvement such as more lectures on project management,

reinforcement of the material and so on. These suggestions are currently being utilized.

The assessment results can be summarized as:

1. After their integration to the curriculum as described, each student team used the

project management tools.

2. The application of the project management tools using Excel was found to be

easy.

3. The importance of the project management for design projects was understood.

4. The introduction of the topics was effective and timely.

5. The impact of the project management tools’ application on the design

performance and time efficiency was recognized.

6. The instruction was effective.

Overall, these results indicate that integration of project management tools using Excel is

successful. In fact, one student stated that “Good time management will help me through

all my work, all through life so will the group skills that I learned.” This statement is so

powerful in that it captures the true intent of this curriculum intervention.
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Table 4. Assessment Results – Open ended questions
Question 1  How did you manage project activities (we had a leader who told us what to do next, etc.)?

Team1 We had a Gantt chart and a table with which we organized what work to be done each week. We tried a

leadership rotation system, where each week someone new was the leader. When that didn't work, we

assigned roles. We decided as a group what should be done next.

Team2 A member showed leadership, but we all did equal amounts of work and managed to get all work done.

Because there were only 4 of us, we basically just moved through the stages as the group decided what

else needed to be done. We made group decisions. We planned it all in the beginning and made sure

to balance all the work to allow ample time in case something took longer than expected.

Team3 We divided up the tasks evenly so no one was stuck doing a lot of work. We all had a job, then put them

together. We followed our Gantt chart and made sure each task was completed on time. I believe we

had a leader, but we all made and agreed on major decisions.

Team 4 We had a leader, but the leading role was switched among group members. We decided as a group what

to do next.

Team 5 We discuss what to do next. There were a couple of leaders in our group, both of whom assigned tasks

for the rest of the group in accordance to the team calendar/Gantt chart/work breakdown structure

matrix.

Team6 We basically discussed the next step in the process and divided up the work. We did have a team leader

who decided what the next step would be. We mostly made all of the decisions together.

Team7 We basically had a leader that fully understood the project and based assignments off of that. We used

our Gantt chart and each of us would volunteer or be assigned a duty for the week. There was no official

team leader. We mostly decided as a group what to do next.

Team8 We discuss all the activities together, although sometimes we digress form our activities topic when we

meet. There were 2 people who started all the discussions and gave tasks to the others. Most of our

decisions were made as a team. Although, one person in our group seemed to be the overall leader, but

we all had our moments. We broke down the jobs that needed to be done and we just split up the work.

Question 2 What techniques, tools you have used while managing your activities? Please list the most important

ones and explain how they helped.

Team1 The main tool we used was the excel workbook. It let us know whether we were on track, what had been

done, and what was left.

Team2 We used good time management and communication skills. We let everyone freely and openly suggest

ideas and think about them. We were good at discussion and using reason to come to conclusions. The

most important tool was simply a list of the tasks. It did help to initially get an idea how long each task

would take. We had meetings and voted to decide on things. We wrote outlines that helped as well.

Good time management will help me through all my work, all through life so will the group skills that I

learned.

Team3 The most important technique we used was time management. This is because we were able to complete

our tasks on time. The Gantt chart showed us what tasks needed done. We communicated through

email.

Team4 Task list, team calendar. Team work, problem solving, organization helped to complete our projects in

the most efficient way possible.

Team 5 Work breakdown structure matrix, this was very helpful in the sense that it outlined everything that was

meant to be done at certain dates, Gantt charts, this was helpful b/c it provided a visual representation of

how our work has progressed.

Team6 The list of jobs and start/end dates kept us on track. The team meeting email also helped to make sure

everyone did their work at least somewhat on time. And this also helped as a reminder to do it and what

your job was.

Team7 We planned and organized by charts and lists. We basically used a spreadsheet to keep track of

everything. The Gantt chart told us when we had to start & finish things by.

Team8 Chart. The progress reports were a very good idea b/c they forced us to keep up the pace. Also, the excel

documents were helpful in knowing what we were supposed to be doing. Excel helped to keep us on

track.
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Table 4 (continued). Assessment Results – Open ended questions

Question 3 Please comment on the ease of applying project management techniques using Excel (Difficult,

confusing, easy, etc.).

Team1 Relatively easy, emailing a result of team meetings was annoying, but it forced us to keep an updated

workbook, which was very beneficial.

Team2 Easy. It kept us on track. It was not a hard technique, although sometimes it seems unnecessary.

Team3 It was rather easy once we understood. Easy, but odd at first. I thought that it was easy to apply our

management techniques. It was easy to implement. But I'm unsure how much good it did.

Team4 Excel was a fair choice, I don't know of anything that would have been better to use. Not hard at all.

Team5 Moderate. Easy.

Team6 Easy, just do it and change it if you need. Easy. I found it confusing.

Team7 It was extremely easy. It was pretty easy. It was relativity easy.

Team8 It was easy to apply project management techniques using excel. Very easy to use and understand.

Question 4 Please provide your opinion on how the instruction for project management can be improved.

Team1 I felt the instruction was very good, sometimes it was a problem for our team to implement it though. I

think it was fine. Have no idea, I think it just depends on how the group functions together.

Team2 I do think the techniques are relatively self-explanatory. Everything was very straightforward on what

we had to do. I really like it the way it is. This was a fun class and I learned a lot. Everything was

explained very well.

Team3 Although, this is not difficult it can be confusing at times. I think we didn't apply them as we could

have, not a matter of not knowing them well enough.

Team4 There could be more lectures on the topic. If we were told to make it more detailed, it would be harder

to fall behind on work. Maybe give past examples of poor project management, and good project

management for inspiration.

Team5 It depends on individual, discipline and responsibility. More emphasis on Gantt charts/work breakdown

structure should be placed as in the beginning it was a bit unclear as to what is expected from these

components although as the course progressed this became much more apparent.

Team6 Handouts would be helpful in reminding students what to do, but they aren't really necessary if you jot

down notes. I think it is good how it is. I think it has to do more with the dynamics of the group.

Team7 It was good, enforce it more during projects. Really nothing can be done to improve. Be more

specific in instruction. Give the students a more structured way to manage their project.

Team8 Provide guidelines. If we did not fall behind in some of the tasks then that would have helped. I don't

know of anyway to improve it. Project management in the end is based on how each individual group

work management is based on how well all group members can work together. I think it is good as it is.

4. Conclusion

This paper presented a spreadsheet-based method for integrating project management

techniques into the project-based engineering design courses. An assessment for the

implementation is also provided, which investigates (1) student learning on the

importance of project management in design projects, (2) the effectiveness and timing of

project management concepts introduced, and (3) the impact of project management

techniques used on their design performance, based on students’ perception of the project

management implementation outlined. The results indicate that the implementation was

very effective. In particular, the integration of project management tools to teaching

design is easy and yields an appreciation for the importance of project management and

its impact on design performance. P
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